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Warranty and Returned Goods Requirements
All standard Beckman Coulter, Inc. policies governing returned goods apply to this 
product. Subject to the exceptions and upon the conditions stated below, the Company 
warrants that the products sold under this sales agreement shall be free from defects in 
workmanship and materials for one year after delivery of the products to the original 
Purchaser by the Company, and if any such product should prove to be defective 
within such one year period, the Company agrees, at its option, either (1) to correct by 
repair or at the Company’s election by replacement, any such defective product 
provided that investigation and factory inspection discloses that such defect 
developed under normal and proper use, or (2) to refund the purchase price. The 
exceptions and conditions mentioned above are as follows:

a. Components or accessories manufactured by the Company which by their 
nature are not intended to and will not function for one year are warranted 
only to reasonable service for a reasonable time. What constitutes a 
reasonable time and a reasonable service shall be determined solely by the 
Company. A complete list of such components and accessories is maintained 
at the factory.

b. The Company makes no warranty with respect to components or accessories 
not manufactured by it. In the event of defect in any such component or 
accessory, the Company will give reasonable assistance to Purchaser in 
obtaining from the manufacturer’s own warranty.

c. Any product claimed to be defective must, if required by the Company, be 
returned to the factory, transportation charges prepaid, and will be returned 
to Purchaser with transportation charges collect unless the product is found 
to be defective, in which case the product must be properly decontaminated 
of any chemical, biological, or radioactive hazardous material.

d. The Company shall be released from all obligations under all warranties, 
either expressed or implied, if any product covered hereby is repaired or 
modified by persons other than its own authorized service personnel, unless 
such repair by others is made with the written consent of the Company.

e. If the product is a reagent or the like, it is warranted only to conform to the 
quantity and content and for the period (but not in excess of one year) stated 
on the label at the time of delivery.

It is expressly agreed that the above warranty shall be in lieu of all warranties of 
fitness and of the warranty of merchantability, and that the company shall have no 
liability for special or consequential damages of any kind or from any cause 
whatsoever arising out of the manufacture, use, sale, handling, repair, maintenance, or 
replacement of any of the products sold under the sales agreement.

Representatives and warranties made by any person, including dealers and 
representatives of the Company, which are consistent or in conflict with the terms of 
this warranty, shall not be binding upon the Company unless reduced in writing and 
approved by an expressly authorized officer of the Company.

Parts replaced during the warranty period are warranted to the end of the instrument 
warranty.

Note:  Performance characteristics and specifications are only warranted when 
Beckman Coulter replacement parts are used.
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1 Introducing the Biomek® 3000 
Laboratory Automation 
Workstation

1.1 Introduction
Welcome to the Biomek® 3000 Laboratory Automation Workstation. This quick-start 
guide is designed to help you learn to use the Biomek Software with your Biomek 
3000 instrument. This quick-start guide includes:

• Getting to Know the Biomek® 3000 Laboratory Automation Workstation 
(this chapter) — a general hardware overview on the Biomek 3000 
Automated Laboratory Workstation and introduction to the Biomek 
Software.

• Learning to Create Methods for the Biomek® 3000 (Chapter 2) — an 
introduction to creating methods for the Biomek 3000 instrument using the 
Biomek Software. This chapter gives instructions on creating, saving, 
running, checking in, and opening a small method.

• Using the Editors While Creating Methods (Chapter 3) — an introduction to 
using the editors in the Biomek Software. This chapter helps you to explore 
the depth of the software by giving instructions on accessing and learning 
more about the editors.
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1.1.1 How to Use This Quick-Start Guide
Read through the quick-start guide while using the links to the specific sections in the 
Biomek® 3000 Laboratory Automation Workstation User’s Manual and Biomek 
Software User’s Manual to further investigate topics that are particularly relevant to 
you. Moving back and forth between this guide and the user’s manuals you will be 
able to begin to learn about the Biomek 3000 instrument and software and also 
become familiar with the manuals and how chapters are arranged.

This quick-start guide can also be used as a tutorial since you’ll be given instructions 
on creating a small method (refer to Chapter 2, Learning to Create Methods for the 
Biomek® 3000) and utilizing the editors (refer to Chapter 3, Using the Editors While 
Creating Methods). Some of the items you’ll create in Chapter 3 may be viewed in the 
method you created in Chapter 2.

In addition to the explanations, graphics, and links to other sources, you will see other 
useful information in the following forms:

Definition
These boxes contain 
brief definitions of 
material that may be 
specific to the Biomek 
3000, or generally 
unfamiliar.

Important Concept
These boxes emphasize 
important concepts 
relevant to the Biomek 
3000 instrument and the 
Biomek Software. Refer 
to the links in this quick-
start guide or the 
Biomek® 3000 
Laboratory Automation 
Workstation User’s 
Manual or the Biomek 
Software User’s Manual 
for more information on 
these important concepts.
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1.2 Biomek® 3000 Laboratory Automation 
Workstation

Your Biomek 3000 Laboratory Automation Workstation (Figure 1-1) is a multiaxis 
liquid-handling instrument sized to fit in a laminar flow or fume hood for sterile or 
hazardous operations. The open architecture design, along with the extensible 
operating software, provides a foundation for integrating current and future specific-
use components.

The Biomek 3000 is a single head instrument with a series of interchangeable tools. 
Different tools provide options for performing a variety of functions, including liquid 
transfer and plate washing operations and moving labware around the deck. The 
modular design of the Biomek 3000 allows expansion of the instrument capabilities to 
include additional operations such as filtration, plate shaking, photometric 
measurement, and high-capacity operation. Regardless of the tool configuration or 
operating components, your Biomek 3000 workstation is controlled through the 
powerful Biomek Software.

Figure 1-1.  Biomek 3000 Laboratory Automation Workstation

1.2.1 Bridge
The bridge is the structure that moves in the X-axis along the tower and front rail. The 
bridge holds the head assembly and enables movement of the head assembly in the Y- 
(front to back) and Z-axes (up and down). Built into the bridge is an indicator light 
that displays the current operational status of Biomek 3000 workstation. The Biomek 
3000 workstation supports only one bridge.

Bridge

Tool 

Back Support

Head Assembly

Deck

Front Rail
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1.2.2 Head Assembly
The head assembly is supported and positioned by the bridge and moves in the Y- and 
Z-axes. The head assembly may hold various interchangeable tools, such as the 
P200L Single-Tip Tool or MP200 Multi-Tip Pipette Tool, that perform liquid-
handling and other operations. The capabilities of the Biomek 3000 instrument 
change with the tool.

1.2.3 Tools
The Biomek 3000 uses interchangeable tools to perform various operations, such as 
aspirating and dispensing, washing, or moving labware around the deck. 

Tools are stored on the deck in a tool rack when not in use and can be installed or 
removed from the head assembly automatically as part of an automated method. This 
allows multiple tool types to provide different functionality to the instrument within a 
method.

Tool types available for the Biomek 3000 head include:

• pipetting tools — single-channel and eight-channel tools used to aspirate and 
dispense liquid (refer to the Biomek® 3000 Laboratory Automation 
Workstation User’s Manual, Chapter 2, Pipetting Tools).

• gripper tool — tool to grasp and move labware around the Biomek 3000 
deck (refer to the Biomek® 3000 Laboratory Automation Workstation User’s 
Manual, Chapter 3, Gripper Tool).

• wash system — the wash system includes single-channel and eight-channel 
tools used to perform washing and bulk dispense operations (refer to the 
Biomek® 3000 Laboratory Automation Workstation User’s Manual, Chapter 
4, Wash System).

• high density replication (HDR) tools — tools used to perform low-volume 
liquid transfer operations by liquid adhesion using stainless steel pins. Pin 
plates are available in 96-pin and 384-pin capacities (refer to the Biomek® 
3000 Laboratory Automation Workstation User’s Manual, Chapter 5, High 
Density Replication System).

Note: HDR tools require at least two tool racks, one for the HDR tool and 
one for the fan unit to dry pins after sterilization

1.2.4 Labware Positioners
Labware positioners are used to hold microplates, tube racks, reservoirs, or tip racks 
on the Biomek 3000 deck. The gripper tool can move labware to and from these 
labware positioners to other labware positioners or devices integrated on the left or 
right side of the Biomek 3000 workstation.

1.2.5 Tool Racks
The tool rack is a special labware positioner used to hold up to five interchangeable 
tools in a single deck position during a method. 

Note:  The gripper tool requires a special tool rack that accommodates the gripper 
tool and up to two additional tools.
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1.2.6 Optional Devices
The following optional devices can be added to the Biomek 3000 workstation to 
accommodate specific operations, such as tip and labware disposal, plate heating and 
cooling, microplate filtration, photometric measurement, and high-capacity operation: 

• Disposal Accessory — provides a waste receptacle for disposing of tips and 
labware from the deck using the gripper tool. Tip boxes or other labware 
may be deposited directly into the disposal accessory, eliminating the need to 
manually dispose of waste (refer to the Biomek® 3000 Laboratory 
Automation Workstation User’s Manual, Chapter 6.7, Disposal Accessory).

• Circulating Reservoir — continually cycles a reagent between off-deck 
reagent bottles and wells of a four-well reservoir positioned on the Biomek 
3000 deck (refer to the Biomek® 3000 Laboratory Automation Workstation 
User’s Manual, Chapter 8, Biomek 3000 Circulating Reservoir).

• Thermal Exchange Unit — heats or cools a reservoir or microplate on the 
Biomek 3000 deck. The temperature is controlled by a user-supplied 
circulating bath (refer to the Biomek® 3000 Laboratory Automation 
Workstation User’s Manual, Chapter 9, Thermal Exchange Unit).

• Filtration System — includes a vacuum valve unit that is connected to the 
Biomek 3000 workstation via RS-485 communication, and a manifold 
system with interchangeable collars to allow collection of filtrates to 
microplates or waste. The filtration system is used to run screening assays 
which require filtration, such as receptor binding and cell-based assays, and 
plasmid DNA purification applications on the Biomek 3000 workstation 
(refer to the Biomek® 3000 Laboratory Automation Workstation User’s 
Manual, Chapter 10, Filtration System).

• Stacker Carousel — provides additional labware capacity for microplates 
and tip boxes to the Biomek 3000 workstation. It includes up to four stacks 
and a shuttle for transporting labware between the Biomek 3000 deck and 
the Stacker Carousel. A Stacker Carousel may be installed on either the left 
side, right side, or both sides (refer to the Biomek® 3000 Laboratory 
Automation Workstation User’s Manual, Appendix B:, Using a Stacker 
Carousel).

• Device Integrations — Several third-party devices, including microplate 
readers and shakers, may be integrated into the Biomek 3000 deck and used 
in an automated method in conjunction with the Biomek 3000 workstation 
(refer to the Biomek® 3000 Laboratory Automation Workstation User’s 
Manual, Appendix C:, DPC MicroMix Shaker).
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1.3 Biomek Software
The Biomek Software is designed to:

• Do a substantial amount of the method-building work for you.

• Allow you to take as much direct and precise control over the method-
building process as you want.

Note:  A method is a series of steps controlling the operations of your Biomek 3000.

The main editor that appears when the software is launched (Figure 1-2) is used to 
build and configure methods:

• Each step is dragged and dropped from a Step 
Palette into the Method View (refer to Chapter 
2, Learning to Create Methods for the Biomek® 
3000). 

• When a step in the Method View is highlighted, 
the corresponding configuration options appear 
in the Step Configuration Area (refer to Chapter 
2, Learning to Create Methods for the Biomek® 
3000).

• The method is customized to the desired level of 
precise control via the editors accessed from the 
Project and Instrument menus (refer to 
Chapter 3, Using the Editors While Creating 
Methods).

Step Palettes
Step Palettes are panes 
in the Biomek main 
editor showing steps 
available for insertion in 
a method. They are 
located on the left of the 
main editor. Use the 
Step Palette Builder to 
add other step palettes. 
Refer to the Biomek 
Software User’s Manual, 
Chapter 29.5, Using the 
Step Palette Builder for 
more information.
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1.4 Starting the Biomek® 3000
To start the Biomek 3000, you will follow the instructions in this chapter to turn on 
the instrument, launch Biomek Software, and home all axes.

1.4.1 Turning On the Biomek 3000
To turn on the Biomek 3000 instrument:

1. Locate the power switch on the right side of the instrument (Figure 1-2).

2. Flip the switch to the On position. The indicator light comes on in solid green. 

1.4.2 Launching the Software
To launch Biomek Software:

1. Choose Start>All Programs>Beckman Coulter>Biomek Software.

2. If Accounts & Permissions is enabled (see sidebar), a dialogue box appears 
requesting you to log in using the user name and password assigned to you by 
your system administrator. Enter the required information. Your account must 
have Develop Methods, Develop Projects, and Setup Instrument 
permissions to complete all parts of this quick-start guide. The Biomek Software 
main editor appears (Figure 1-2).

Note:  If you are logging into Biomek Software for the first time, you must enter 
a new password. Remember your new password; you will need to enter it each 
time you access Biomek Software.

Figure 1-2.  Biomek Software main editor

Accounts & 
Permissions

When enabled, Accounts 
& Permissions is an 
integrated set of features 
built into the software to 
assist users in complying 
with electronic signature 
requirements for closed 
systems. The 
functionality for 
Accounts & Permissions 
is included in the Biomek 
Software installation and 
provides control over 
who can create and run 
methods, and who may 
only run validated 
methods. Refer to the 
Biomek Software User’s 
Manual, Chapter 2, 
Using Accounts & 
Permissions.

Method View
The method is built step 
by step in this area. 

Step Configuration Area
When a step is highlighted in the 
Method View, the corresponding 
configuration appears in this area.

Current Deck Display
Displays the status of the deck upon 
completion of the previous step.

Other editors are available from the 
Project and Instrument menus.

Biomek 3000 Step Palette
Displays the special steps 
available for Biomek 3000, 
including those to load, unload, 
and change tools.

Basic Step Palette
Displays the steps that provide 
essential functionality, 
including instrument setup and 
labware manipulation. 
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1.4.3 Homing All Axes of the Biomek® 3000 Pod
Every time the Biomek 3000 is turned on, you’ll have to Home All Axes. This 
automatic process initiates the pod and defines the home position from which all 
subsequent moves are determined.

To home all axes:

1. From the Instrument menu, choose Home All Axes. A Warning appears.

2. Make sure that all warnings are addressed and choose OK. The pod is homed and 
the instrument is now ready for use.

Proceed through this quick-start guide while using the links to the user’s manuals to 
learn more about the Biomek 3000 liquid-handling system.

Home All Axes gives 
the instrument a point of 
reference from which to 
make subsequent moves. 
The home position is to 
the left and back of the 
Biomek 3000 deck.

Home All Axes
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2 Learning to Create Methods for 
the Biomek® 3000

2.1 Overview
In this chapter you will be given information and instructions for building a small 
method using Biomek Software. A method is a series of steps that control the 
operation of your Biomek 3000. 

The method you complete in this chapter represents basic operations and is intended 
simply to familiarize you with the Biomek 3000, and to create a basic understanding 
of method-building opportunities. 

Read the information in this chapter and complete the tutorial steps provided. After 
you have completed the instructions, or if you need additional information along the 
way, use the links provided to access the suite of user’s manuals provided during 
installation. These manuals include Biomek Software User’s Manual and Biomek® 
3000 Laboratory Automation Workstation User’s Manual. Each manual contains 
comprehensive information about the possibilities designed into the Biomek 3000.

In this chapter, you’ll learn:

• Creating a New Method (Section 2.2) 

• Configuring the Instrument Setup Step (Section 2.3)

• Configuring a Transfer Step (Section 2.4)

• Configuring a Move Labware Step (Section 2.5)

• Using the Finish Step (Section 2.6)

• Saving a Method (Section 2.7)

• Running a Method (Section 2.8)
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2.2 Creating a New Method
In this chapter, you will build a simple method that transfers liquid between labware. 
In building this method, you will:

• Populate the deck with labware using the Instrument Setup step.

• Transfer liquid with an MP200 Multi-Tip Pipette Tool using a Transfer step.

• Move labware with the Gripper Tool using a Move Labware step.

Note: A gripper tool rack must be installed on the Biomek 3000 deck to 
store a gripper tool when not in use.

When you create a new method by dragging a step into the Method View, the Start 
and Finish steps appear automatically. You will use an Instrument Setup Step to tell 
Biomek Software where you have physically placed labware on your deck.

Before proceeding with this quick-start method, make sure that:

• an MP200 Multi-Tip Pipette Tool and Gripper Tool are added in Hardware 
Setup (refer to Section 3.6, Using Hardware Setup).

• the deck layout in the Deck Editor contains at least one GripperToolRack, 
one ManualLatch, and four Biomek3000Positions (refer to Section 3.7, 
Creating a New Deck).

Note: If your instrument configuration does not have a gripper tool, a 
standard ToolRack position can be used instead of the GripperToolRack.

• the deck is framed (refer to the Biomek® 3000 Laboratory Automation 
Workstation User’s Manual, Chapter 13, Framing the Biomek® 3000).

If using Accounts & 
Permissions . . . 
You must have Develop 
Methods permission to 
create methods. Refer to 
the Biomek Software 
User’s Manual, Chapter 2, 
Using Accounts & 
Permissions, for more 
information.
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You launched Biomek Software in Chapter 1, you are now going to create a small 
method:

1. Drag and drop an Instrument Setup into the Method View. A new method is 
created and assigned the default name Method1 [New] (Figure 2-1).

Figure 2-1.  Biomek Software main editor for a Biomek 3000 instrument

Note:  Your deck layout may differ slightly from the deck shown in Figure 2-1, 
depending on how your Biomek 3000 instrument is physically set up.

As you can see, two steps automatically appear in every method created and executed 
by the Biomek Software:

• Start — the first step in a method; allows 
creation of global variables that are applicable 
to the entire method. Refer to the Biomek 
Software User’s Manual, Chapter 12.2.1, 
Configuring the Start Step, for information on 
creating variables in the Start step.

• Finish — the final step in a method; provides 
options to clear the Biomek 3000 deck, clear the 
devices on the deck, unload tips from the pod, 
and clear all global variables. Refer to the 
Biomek Software User’s Manual, Chapter 
12.2.2, Configuring the Finish Step, for 
information on configuring other options for the Finish step.

Proceed to Section 2.3, Configuring the Instrument Setup Step to learn how to 
configure the Instrument Setup step you just inserted into the method view.

Method View
The method is built 
step by step in this 
area. 

Step Configuration Area
When a step is highlighted in the 
Method View, the corresponding 
configuration appears in this area.

Current Deck Display
A dynamically updated 
representation of the devices 
and labware positioned on the 
Biomek 3000 deck. 

Basic Step Palette
Displays the steps 
available for insertion 
into a method. 
Additional steps are 
available through other 
step palettes.

Variables
A variable is a value that 
has been assigned a 
name that may be 
referenced repeatedly 
during a method. Refer 
to the Biomek Software 
User’s Manual, Chapter 
13, Using Variables and 
Expressions in a Method 
for more information.
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2.3 Configuring the Instrument Setup Step 
CAUTION: An inaccurate Instrument Setup may result in pod and 
labware collisions, or in inappropriate pipetting.

When creating Biomek methods, it is important to use the Instrument Setup step, 
along with the Deck Editor, to tell the software what labware and devices are on the 
deck for obstacle avoidance (see sidebar). You’ll learn more about the Deck Editor in 
the next chapter (refer to Section 3.7, Creating a New Deck).

Figure 2-2.  Instrument Setup step in the Method View

When building a method, 
you must ALWAYS use 
the Deck Editor and 
Instrument Setup step 
to tell the software what 
labware and ALPs are on 
the deck and the position 
each occupies. If this is 
not done, the pod could 
collide into these objects 
as it moves around the 
deck during a method 
run.

Obstacle 
Avoidance 
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To configure the Instrument Setup step for your new method:

1. In Deck, make sure the default deck layout (Deck1) is selected. The Instrument 
Setup step uses a deck layout as a map for the placement of labware on the deck 
and external hardware devices, such as stacker carousels.

2. Drag and drop the following labware on the Deck Layout Display:

• an AP96_200uL to ML1 or AL1. 

Note: Tip boxes must be placed in either a manual latch (ML1) or 
auto-latching (AL1) tip rack holder to precisely position tip racks so that 
pipetting tools can accurately load and unload tips. Make sure that the 
latch is securely holding the tip rack in position.

• a Reservoir to P3.

• a BCFlat96 to P4. Your screen should look similar to Figure 2-3.

Note:  To remove unwanted labware from the Deck Layout Display during 
setup, drag and drop the labware to the Clear (trash) icon.

Figure 2-3.  Instrument Setup step with labware added

If you want to use a 
labware type that does 
not appear in the 
available labware list, use 
the Labware Type 
Editor to create a new 
labware type. In Section 
3.3, Creating New 
Labware in the Labware 
Type Editor, you will 
create a new labware type 
in the Labware Type 
Editor.

Creating Labware 

Drag the desired 
labware graphic to 
the desired position 
on the Deck Layout 
Display.

Deck Layout 
Display

From the Deck Layout 
Display, double-click 
the labware graphic to 
display Labware 
Properties.

AP96_200uL 
on ML1

BCFlat96 
on P4

Tool rack Reservoir 
on P3
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3. From the Deck Layout Display, double-click the tool rack to display Labware 
Properties (Figure 2-4). 

Figure 2-4.  Labware Properties for tool rack

Note:  Your Labware Properties for the tool rack may contain more tools on 
the right side, depending on your instrument configuration.

4. Drag the Gripper tool to the gripper tool position on the tool rack (the larger 
position on the right).

5. Drag the MP200 tool to either of the two remaining tool positions.

6. Choose OK to close Labware Properties.

7. From the Deck Layout Display, double-click the reservoir on P3 to display 
Labware Properties (Figure 2-5).

Figure 2-5.  Labware Properties for Reservoir on P3

Drag the Gripper tool 
to the gripper position 
on the tool rack.
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8. In Name, enter Resv in Labware Properties.

9. In Labware contains, select Known from the pull-down menu.

10. In volume, enter 100000. This means that you know you have 100000 
microliters of liquid in the reservoir.

11. In liquid type, select Water_MP200_P200 from the pull-down menu. 
Labware Properties for the Reservoir should look like Figure 2-5.

12. Choose OK to close Labware Properties.

13. Double-click the labware on P4 and name it Dest1 in Labware Properties.

14. Choose OK to close Labware Properties.

Note:  The default settings in Labware Properties will be used for the tip box; 
however, you can refer to the Biomek Software User’s Manual, Chapter 15.2.5.1, 
Configuring Labware Properties for Tips, to learn more about configuring a tip 
box.

15. Select Pause to confirm setup?. You will see a confirmation prompt when 
you run your method in Section 2.8, Running a Method. 

16. Leave the Verify Pod Setup option as is. This setup is used to inform the 
software of the current state of the pod; for example, if the pod already has a tool 
loaded at the start of the method.

It is helpful to name 
labware, particularly 
when you use lots of 
labware on the deck. You 
can assign a name that 
identifies the contents of 
the labware or a 
descriptive name that fits 
the work being done in 
the laboratory. Naming 
labware can reduce 
confusion. 

Naming Labware 
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Your Instrument Setup step is now configured and the main editor should look like 
Figure 2-6.

Note:  To learn more about the Instrument Setup step, refer to the Biomek Software 
User’s Manual, Chapter 15.2, Instrument Setup Step.

Figure 2-6.  Instrument Setup step with labware named

Next you will configure a Transfer step using an MP200 tool. If your instrument 
configuration does not include an MP200 tool, any pipetting tool may be substituted.
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2.4 Configuring a Transfer Step
The Transfer step transfers liquid from a single source to one or more destinations. 
You are going to insert a Transfer step into the method and configure it to move 
liquid from your source reservoir (Resv) to your destination microplate (Dest1) 
using an MP200 Multi-Tip Pipette Tool. 

Note:  Refer to the Biomek Software User’s Manual, Chapter 15.3, Configuring 
Transfer and Combine Steps, for complete information on configuring the Transfer 
and Combine steps.

2.4.1 Inserting a Transfer Step
To insert a Transfer step into your method:

Drag and drop a Transfer step from the Step Palette into the Method View just 
below the Instrument Setup step. Notice that the Current Deck Display shows 
the current position of all labware on the deck (Figure 2-7).

You will complete three sections to configure the Transfer step for this method:

• Section 2.4.2, Configuring Tip Handling

• Section 2.4.3, Configuring Source Labware

• Section 2.4.4, Configuring Destination Labware

Figure 2-7.  Transfer step inserted into the Method View

A Transfer step loads 
tips, aspirates and 
dispenses liquid, and 
unloads tips. This 
eliminates the need to 
insert four separate steps 
to complete a liquid 
transfer. However, there 
are steps in Biomek 
Software that allow these 
steps to be performed 
individually on the 
Intermediate Step Palette 
(refer to the Biomek 
Software User’s Manual, 
Chapter 16, Using the 
Intermediate Step 
Palette).

Transfer Step

Current Deck Display
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2.4.2 Configuring Tip Handling
The Transfer step automatically loads an appropriate 
tool if one is not already loaded. However, if you want to 
use a specific tool for the Transfer step, a tool can be 
loaded by inserting a Load Tool step prior to the 
Transfer step. For this quick-start method, it is not 
necessary to insert a Load Tool step since there is only 
one pipetting tool on the deck.

To configure tip handling:

1. In Tip Handling, make sure Load is checked

2. Click on the AP96_200uL tip box on ML1 in the 
Current Deck Display to load AP96_200µL tips as 
part of the Transfer step.

3. Make sure unload them is selected in the next 
field.

4. Check Change tips between sources.

5. Uncheck Change tips between destinations.

6. Your tips are configured for your liquid transfer, so 
click the up arrow next to Tip Handling to collapse 
the configuration. This allows more room for the step configuration (Figure 2-8). 
The text displayed reflects your tip handling configuration.

Figure 2-8.  Transfer step with Tip Handling collapsed

Configuring Tip 
Handling is not always 
required because the 
Biomek 3000 locates and 
loads clean tips 
automatically during a 
Transfer step. Refer to 
the Biomek Software 
User’s Manual, Chapter 
15.3.1, Configuring Tip 
Handling, for 
information on other tip 
handling options, such as 
Change tips between 
destinations.

Tip Handling 
Load Tool Step

The Load Tool step is 
found on the Biomek 
3000 Step Palette and is 
used to load a specific 
tool to the head 
assembly. If a tool is 
already loaded to the 
head assembly, that tool 
must first be removed 
using an Unload Tool 
step, or a Change Tool 
step may be used to 
execute both actions. 
Refer to the Biomek 
Software User’s Manual, 
Chapter 20, Using the 
Biomek 3000 Step 
Palette.

Use this arrow 
to collapse 
and expand 
Tip Handling.
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2.4.3 Configuring Source Labware
To configure the labware named Resv as source labware in the Transfer step:

1. Click on Click here to add a source.

2. Click on Resv labware sitting on P2 in the Current Deck Display.

Note:  The information you supplied during Instrument Setup is displayed in 
the source labware configuration.

3. Leave the Auto-Select checkbox selected to use the technique selected by 
Biomek Software.

4. Right-click on the large tip illustration next to the microplate graphic in the 
configuration and choose Measure from the Bottom.

5. To adjust and set the aspirate height for the depth the tip descends into the 
reservoir, place the mouse cursor over the tip illustration. When the cursor 
turns into a hand, hold the left mouse button down to move the hand up and down 
until the depth is as close to 2.00 mm from bottom as you can get. Then adjust 
the height precisely to 2.00 mm using the following note. This will be your 
aspirate height for this transfer.

Note:  After you click on the tip, you can adjust the height more precisely by 
using the up or down arrow keys on your keyboard while holding the Alt key. 
You can also right-click on the graphic, then select from the menu that appears to 
adjust the height.

The source labware configuration is complete and the main editor now looks like 
Figure 2-9.

Figure 2-9.  Transfer step with source labware configured

Techniques allow 
pipetting settings to be 
saved globally and used 
in any method. Biomek 
Software includes several 
predefined techniques. If 
Auto-Select is chosen in 
a pipetting step, such as 
Transfer, each time a 
method is created, 
Biomek Software 
automatically selects 
the technique most 
appropriate for the 
pipetting operation.

Techniques 

Transfer Details
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2.4.4 Configuring Destination Labware
To configure the labware named Dest1 as destination labware in the Transfer step:

1. Before you configure the destination labware, click the down arrow in Transfer 
Details located just above the Current Deck Display to collapse that section. You 
will not be making any changes to the options in this section.

2. Click on Dest1 sitting on P6 in the Current Deck Display. This one operation 
accomplishes the same task as steps 1 and 2 of Section 1.5.2 Configuring Source 
Labware.)

Note:  Notice that the source labware configuration is now replaced with a brief 
sentence summary of the setup. If you want to reopen this source configuration 
for any reason, click anywhere in the collapsed configuration area.

3. The Volume field is highlighted, which allows you to designate the amount of 
liquid to be dispensed. For this tutorial, you’re transferring 100 µL; so, type 100 
into the Volume field.

Note:  The volume is measured in microliters (µL) automatically and indicates 
the amount of liquid that will be dispensed (100 µL) into each of the 96 wells; so, 
in this case, you’re dispensing a total of 9600 µL into the 96-well microplate.

4. In of, select Water_MP200_P200 as the liquid type, if necessary. Biomek 
Software comes with three liquid type definitions for water: Water, 
Water_MP20_P20, and Water_MP200_P200. You should always use the 
definition that includes the tool used for the transfer for best results.

5. Right-click on the large tip illustration and choose Measure from Bottom.

6. Set the dispense height in the large tip illustration to 4.00 mm from bottom, 
using the same technique as you used for setting the aspirate height.

Note:  If you accidentally open too many destination configurations, all you 
have to do is right-click on the title above the graphic of the plate in the 
configuration. Click on Delete from the popup menu and the entire 
configuration goes away.

Transfer details include a 
stop condition for 
transfer operations; a 
repeat pipetting 
configuration; and a 
maximum tolerance in 
timing between transfer 
operations. Refer to the 
Biomek Software User’s 
Manual, Chapter 15.3.4, 
Configuring Transfer 
Details.

Transfer Details
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The destination labware is now configured, and the main editor looks like Figure 2-
10. The Transfer step is now configured to transfer 100 µL from the source reservoir 
Resv to the destination microplate Dest1.

Figure 2-10.  Transfer step with Destination configured

Note:  The method view changes to reflect the amount transferred when the next step 
is configured.

The Transfer step configuration is now complete. In the next section, you will 
configure a Move Labware step to move the destination labware to a different deck 
position using the gripper tool. If your instrument configuration does not include a 
gripper tool, skip to Section 2.6, Using the Finish Step, to learn how long the method 
will take to run.

Caption changes 
to reflect the 
amount transferred 
when the next step 
is configured.
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2.5 Configuring a Move Labware Step
If your instrument configuration does not include a 
gripper tool, you cannot move labware; continue to 
Section 2.6, Using the Finish Step. 

The Move Labware step automatically changes tools to 
the gripper tool and moves labware from one position on 
the Biomek 3000 instrument deck to another position. 
Move Labware can also be used to remove labware 
from the deck by placing it in an appropriate disposal 
position, or to an external hardware device without 
halting the Biomek 3000 instrument or the method. 

Note:  Refer to the Biomek Software User’s Manual, 
Chapter 15.4, Move Labware Step.

To configure the Move Labware step to move your 
Dest1 labware at position P6 to another deck position: 

1. Insert a Move Labware step into the Method View.

2. In Move labware from, select P4 from the drop-down menu.

3. In Move labware to, select P6 from the drop-down menu. The main editor 
should now look like Figure 2-11.

Figure 2-11.  Configured Move Labware step

The Move Labware step configuration is complete. Now move on to Section 2.6, 
Using the Finish Step, to learn how long the method will take to run.

Gripper Tool
The gripper tool is a 
specialized tool that is 
loaded onto the head 
assembly and allows 
the Biomek 3000 
workstation to grasp and 
move labware around 
the Biomek 3000 deck. 
Refer to the Biomek® 
3000 Laboratory 
Automation Workstation 
User’s Manual, Chapter 
3, Gripper Tool.
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2.6 Using the Finish Step
Your liquid transfer is set up, so you can see how long it will take to run the entire 
method by using the Finish step.

1. Click on the Finish step in the Method View.

2. Check the status bar at the bottom of the editor for a display of the Estimated 
Time for Completion (ETC). For this method, the ETC is approximately 2:24. 

Note:  Your ETC may vary slightly. That’s OK. 

Note:  Refer to the Biomek Software User’s Manual, Chapter 12.2.2, Configuring the 
Finish Step, for information on configuring the Finish step.

2.6.1 Handling Configuration Errors
If there is a step configuration error in your method, when you click on the Finish or 
any step that occurs after the step with error, the step with the error is highlighted in 
red (Figure 2-12) and the ETC is displayed as Failed. The error message also is 
displayed in the status bar or when hovering the mouse over the highlighted step. Use 
the message to correct the error and reconfigure the step.

Note:  Refer to the Biomek Software User’s Manual, Chapter 25, Handling and 
Preventing Errors.

Figure 2-12.  Quick-Start method with error

Error Message
The error message 
is displayed in the 
status bar and as a 
tool tip.

ETC
Displayed as 
Failed when 
there is an error.
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2.7 Saving a Method
After you’ve clicked on Finish step, you can save or 
check in your method. We will just save it for now.

1. Choose File>Save from the toolbar. Save Method 
As appears.

Figure 2-13.  Save Method As

2. Enter Quick-Start Method and choose OK. The 
method editor now looks like Figure 2-14.

Figure 2-14.  Quick-Start method saved and named

Move on to Section 2.8, Running a Method, to run your saved Quick-Start method.

Methods and 
Project Files

Methods are saved as 
elements of a project file, 
not as separate method 
files. Saving a method 
only saves the current 
status of the method. It 
does not create a revision 
or check in project items 
as revisions. Refer to the 
Biomek Software User’s 
Manual, Chapter 6, 
Understanding and 
Using Project Files.

Check In
Checking in a method is 
similar to saving a 
method, but in addition 
creates a new revision of 
the method, checks in all 
project items of the 
project file, and creates 
new revisions for any 
items that have changed. 
You will check in the 
method later, in Section 
3.5, Checking In a 
Method and Project 
File.
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2.8 Running a Method
Next you will run the method you just created using the simulator. The simulator 
allows you to watch the method on your screen without actually running the method 
on an instrument.

To run your saved method:

1. If you do not see the Simulation Display button on the toolbar (Figure 2-15), 
from the Instrument menu, choose Hardware Setup. Biomek Hardware 
Setup appears.

Figure 2-15.  Hardware Setup

2. In Port, select Simulate. 

3. Choose Accept to save changes and close Hardware Setup. Biomek Software 
is now running in simulation mode.
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4. Click on the green arrow button on the toolbar. The simulation display is 
automatically launched and the step configuration area is replaced with a three-
dimensional model of your Biomek 3000 (Figure 2-16). The deck confirmation 
prompt (Figure 2-17) appears on top of the main editor.

Figure 2-16.  Biomek 3000 simulator displayed

Figure 2-17.  Deck confirmation prompt for Quick-Start method

Simulation display button
Click to toggle the view of the 
simulator on and off.
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5. Choose OK. The prompt closes and the method continues. View the method on 
screen as it proceeds in the simulator. The method can also be followed in the 
Method View as steps are highlighted in green as they are executed.

Note:  If you are running this method on your instrument instead of the 
simulator, make sure that the physical deck layout matches the expected deck 
layout shown in the deck confirmation prompt before you choose OK.

You can proceed directly to Chapter 3, Using the Editors While Creating Methods, to 
learn about the editors you’ll use for customizing your methods.





Biomek® 3000 Laboratory Automation Workstation Quick-Start Guide

3-1

3 Using the Editors While 
Creating Methods

3.1 Overview
This chapter presents step-by-step information to help you learn how to use the 
editors. You can follow the instructions to use the editors or read through this chapter 
without performing the numbered steps. Links to specific sections offer complete 
information on all the editors and allow you to use this chapter in conjunction with the 
Biomek Software User’s Manual.

The editors allow your method to be customized to your special requirements. You 
can go beyond the predefined project items and instrument configurations; manually 
control the pod; restore instrument settings and project files; and configure external 
devices using specific editors.

The editors are accessed from the Project or Instrument menus located on the 
toolbar of the Biomek main editor (Figure 3-1). 

This chapter includes the following information:

• General Description of Editors (Section 3.2)

• Creating New Labware in the Labware Type Editor (Section 3.3)

• Creating a New Pattern (Section 3.4)

• Checking In a Method and Project File (Section 3.5)

• Using Hardware Setup (Section 3.6)

• Creating a New Deck (Section 3.7)

• Manually Controlling the Pod (Section 3.8)
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3.2 General Description of Editors
Several editors are used to configure Biomek Software to control your Biomek 3000 
instrument. Editors are accessed from one of two menus: 

• Project menu (Figure 3-1)

OR

• Instrument menu (Figure 3-1)

Figure 3-1.  Biomek main editor

Following is a brief description of the editors available from the two menus displayed 
in Figure 3-1. If you would like to learn more about a specific editor, refer to the 
referenced chapter for more information.

You will work with four of the more commonly used editors and Manual Control in 
this quick-start guide. 

If using Accounts & 
Permissions . . . 
You must have Develop 
Projects and Setup 
Instrument permissions 
to access the editors on the 
Project and Instrument 
menus. Refer to the 
Biomek Software User’s 
Manual, Chapter 2, Using 
Accounts & Permissions, 
for more information.

Project
Includes access to the 
following:
Labware Type Editor 
Tip Type Editor
Well Pattern Editor
Technique Browser
Liquid Type Editor
Pipetting Template Editor

Instrument
Includes access to the 
following:
Hardware Setup
Deck Editor
Device Editor
Manual Control
Import/Export Utility
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3.2.1 Project Menu
The editors on the Project menu (Figure 3-1) allow project items to be created, 
copied, revised, and renamed. They include the following:

• Labware Type Editor — allows you to add new labware types, copy 
labware types, delete labware types, rename labware types, and edit labware 
type properties (refer to the Biomek Software User’s Manual, Chapter 7, 
Creating and Modifying Tip and Labware Types).

Note: Refer to Section 3.3, Creating New Labware in the Labware Type 
Editor, in this quick-start guide to follow step-by-step instructions to create 
new piece of labware.

• Tip Type Editor — allows you to add new tips types, remove tip types, and 
change tip properties (refer to the Biomek Software User’s Manual, Chapter 
7, Creating and Modifying Tip and Labware Types).

• Well Pattern Editor — allows patterns for hitting specific wells to be 
created and stored (refer to the Biomek Software User’s Manual, Chapter 11, 
Creating Well Patterns).

Note: Refer to Section 3.4, Creating a New Pattern, in this quick-start 
guide to learn how to create a well pattern.

• Technique Browser — allows you to customize techniques for your 
specific needs and save them for use in future methods (refer to the Biomek 
Software User’s Manual, Chapter 9, Understanding and Creating 
Techniques).

• Liquid Type Editor — allows you to create new liquid types or to modify 
existing liquid types (refer to the Biomek Software User’s Manual, Chapter 
8, Understanding and Creating Liquid Types).

• Pipetting Template Editor — allows you to create or modify pipetting 
templates that configure the precise actions during pipetting operations 
(refer to the Biomek Software User’s Manual, Chapter 10, Using the 
Pipetting Template Editor).

3.2.2 Instrument Menu
The editors on the Instrument menu (Figure 3-1) allow instrument configuration to 
be changed. They include the following:

• Hardware Setup — if you change the configuration of your instrument, it 
is used to install, configure, and remove other devices (refer to the Biomek® 
3000 Laboratory Automation Workstation User’s Manual, Chapter 12, 
Configuring the Biomek® 3000 in Hardware Setup).

• Deck Editor — used to define and change deck configurations and frame 
the deck (refer to the Biomek Software User’s Manual, Chapter 5, Preparing 
and Managing the Deck).

• Device Editor — external devices may be integrated to your Biomek 3000 
instrument. In order to use the device, it must be configured through the 
Device Editor (refer to the Biomek Software User’s Manual, Chapter 22.4.1, 
Configuring Devices Using the Device Editor). 
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• Manual Control — allows you to control the movement of the bridge, head 
assembly, and grippers independently of a method. It is used to control the 
pod when framing the gripper tool and when recovering from errors (refer to 
the Biomek® 3000 Laboratory Automation Workstation User’s Manual, 
Chapter 14, Manually Controlling the Biomek® 3000 in Biomek Software).

Note: Refer to Section 3.8, Manually Controlling the Pod, in this quick-
start guide to learn how to manually move a pod to another position after 
using Z-Max to raise it to the highest configured height.

• Import/Export Utility — allows you to import and export instrument settings 
(decks, framing tools, pod settings) as import files (.imp) (refer to the 
Biomek Software User’s Manual, Chapter 3, Using Instrument Files and 
Settings).
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3.3 Creating New Labware in the Labware Type Editor
The Labware Type Editor is used to create labware definitions so you can use 
labware that is not predefined in Biomek Software in your methods .

Assume that you have new labware that is very similar to a BCFlat96, but some 
specifications are slightly different so you must create a new labware type in the 
Labware Type Editor in order to use this new type in your methods.

Refer to the Biomek Software User’s Manual, Chapter 7, Creating and Modifying Tip 
and Labware Types, for further information on using the Labware Type Editor.

Note:  Do not run a method outside of the simulator using the labware you create 
here; the specifications may not be accurate for the physical piece of labware you use 
in this tutorial method (see sidebar).

To create new labware in the Labware Type Editor:

1. From the Project menu, choose Labware Type Editor. Labware Types 
appear (Figure 3-2)

Figure 3-2.  Labware Types

When creating a new 
labware type, it is 
important that the 
labware dimensions are 
entered precisely per the 
manufacturer’s 
specifications. An 
incorrect labware 
definition could result in 
a number of problems, 
including collisions, 
gripper errors, or poor 
pipetting performance.

Labware 
Definitions
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2. Click on BCFlat96 and choose Copy. Copy Labware Type appears (Figure 3-
3).

Figure 3-3.  Copy Labware Type

Note:  To retain the dimensions of predefined labware in Biomek Software, it is 
important to copy and then edit the copy of the labware type rather than just 
editing the predefined labware to meet the new labware specifications. 

3. Enter NewLabwareQuickStart and choose OK. The copy of BCFlat96 is 
created with the specified name and appears in Labware Type Editor (Figure 3-
4).

Figure 3-4.  NewLabwareQuickStart in Labware Type Editor

Copy of BCFlat 96 renamed to 
NewLabwareQuickStart
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4. Double-click the NewLabwareQuickStart graphic. NewLabwareQuickStart 
appears (Figure 3-5).

Figure 3-5.  NewLabwareQuickStart

Note:  Each piece of labware in Labware Types has its own mini-editor similar 
to Figure 3-5 to allow specifications to be revised and saved.

5. In Height, enter 1.46 and choose Save. You have created a new piece of 
labware in the Labware Type Editor.

6. Choose Exit to close the Labware Type Editor.
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3.4 Creating a New Pattern 
The Well Pattern Editor is used to create and store patterns for accessing specific 
wells in methods. There are also well patterns already created in Well Patterns that 
may be used or copied to create new patterns. The patterns created and stored in Well 
Patterns are accessible in the Transfer and Combine steps.

Assume that you want to create a new well pattern based on the 
NewLabwareQuickStart labware you created in the Labware Type Editor.

To create a new well pattern in the Well Pattern Editor:

1. From the Project menu, choose Well Pattern Editor. Well Patterns appears 
(Figure 3-6).

Figure 3-6.  Well Patterns
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2. Choose New. New Pattern appears (Figure 3-7).

Figure 3-7.  New Pattern

3. Highlight NewLabwareQuickStart and choose OK . Figure 3-8 appears.

Figure 3-8.  Well Patterns based on Pattern 96
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4. While holding down the Shift key, select the wells for the new pattern so it looks 
like Figure 3-9.

Figure 3-9.  Wells chosen for the new pattern

5. Choose Rename to rename the new pattern. Rename Pattern appears (Figure 
3-10).

Figure 3-10.  Rename Pattern
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6. Enter LabwareQuickStart and choose OK. Figure 3-11 appears.

Figure 3-11.  New pattern renamed

7. Choose Save to save LabwareQuickStart in Well Patterns.

Note:  Refer to the Biomek Software User’s Manual, Chapter 11, Creating Well 
Patterns, for more information on creating well patterns.
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3.5 Checking In a Method and Project File
Checking in a method is similar to saving a method, but also creates a revision record 
of the method and checks in all project items of the project file and creates new 
revisions for any items that have changed. 

You will check in your Quick-Start method, along with the new labware and well 
pattern you just created.

To check in your method with the new labware and well pattern:

1. From the File menu, choose Check In. Check In appears with the new labware 
type and well pattern.

Figure 3-12.  Check In

2. Choose OK to check in the new revisions of project items.

Notice that the method name in the Biomek main editor title bar changes to Quick-
Start Method [Revision 1: Development]. If Accounts & Permissions is enabled, 
other dialogues appear and more steps are required for checking in methods. Enter a 
reason and your password to check in the method and project. (refer to the Biomek 
Software User’s Manual, Chapter 12.10, Checking In a Method). 

Note:  If using Accounts & Permissions, methods may also be validated by choosing 
Validate from the File menu (see sidebar).

Changes made to any 
item in a project file are 
saved but do not become 
revisions until checked 
in. Once checked in, a 
new revision is created 
for the project items. 
Revisions can never be 
lost. If a project item is 
later modified or deleted, 
any revision of the 
project item may be 
restored.

Revisions

When Accounts & 
Permissions is enabled, 
methods may be 
validated. A validated 
method is a revision of a 
method that is checked in 
with a reason, with or 
without an electronic 
signature, and protected 
from further 
modification. Revisions 
of project items required 
to run the validated 
method are also checked 
in and protected from 
further modification. 
This ensures that 
validated method runs are 
reproducible. Refer to the 
Biomek Software User’s 
Manual, Chapter 12.15, 
Checking Out a Method.

Validated Methods 
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3.6 Using Hardware Setup
While a Beckman Coulter Service Engineer normally installs and configures new 
devices in Hardware Setup, it may be necessary for you to install, configure, and 
remove other devices using Hardware Setup if you change the configuration of your 
instrument. 

You will also need to configure Hardware Setup if you have a new tool that you 
want to use with your Biomek 3000 instrument.

You will add a P200L Single-Tip Pipette Tool to the list of tools available. Adding a 
tool in Hardware Setup makes it available to add to a tool rack in the Instrument 
Setup step and use it in a method.

To add a new tool in Hardware Setup:

1. Choose Instrument>Hardware Setup. Hardware Setup appears (Figure 3-
13). 

Figure 3-13.  Hardware Setup

2. In the left pane, right-click Tools and choose Add Device from the menu that 
appears. A list of all the different tool types appears.

Right-click Tools bring up this menu.



3-14 Using the Editors While Creating Methods

Beckman Coulter, Inc.

3. Select P200L from the list. A P200L tool is added to the list of tools in the left 
pane. Note the asterisk to the right of the tool name. This indicates the tool has 
been added or modified and changes have not been saved.

Figure 3-14.  Hardware Setup with new tool added

4. Click on P200L in the left pane to display the tool configuration in the right 
pane. 

5. If this new tool corresponded to a physical tool that would be used with the 
instrument, you would enter the serial number printed on the tool label in Tool 
Serial Number.

Note:  The other fields may be used to modify the performance of the tool. 
However, Tool Conversion Slope and Capacity should only be changed if you 
are instructed to do so by a Beckman Coulter support or service representative. 
Refer to the Biomek® 3000 Laboratory Automation Workstation User’s Manual, 
Chapter 12, Configuring the Biomek® 3000 in Hardware Setup, for more 
information on adding and configuring tools in Hardware Setup.

6. Since this tool does not correspond to a physical tool, right-click P200L in the 
left pane and select Remove Device to remove the tool from Hardware 
Setup.

7. Choose Accept to close Hardware Setup.

The newly added P200L 
tool appears here.
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3.7 Creating a New Deck
A deck in the Biomek Software refers to the software representation of the physical 
Biomek 3000 instrument deck. The Deck Editor is used to define and change deck 
configurations. A deck stores framing information and device associations for each 
position on the deck. Decks can be used for multiple methods and are stored in the 
Deck Editor.

Assume you have added a second tool rack to your deck and now must create another 
deck in the Deck Editor that reflects that addition to the physical deck.

Note:  Refer to the Biomek Software User’s Manual, Chapter 5, Preparing and 
Managing the Deck, for detailed information on using the Deck Editor.

To create a new deck in the Deck Editor:

1. Choose Instrument>Deck Editor. Deck Editor appears (Figure 3-15).

Figure 3-15.  Deck Editor

2. Select New Deck. Choose a name for this deck appears (Figure 3-16).

Figure 3-16.  Choose a name for this deck

3. Enter TwoToolRacks and choose OK. TwoToolRacks appears.

4. Click and hold the mouse button on ToolRack from the Devices Types List. 
Locations capable of supporting that ALP are indicted in the Deck View by 
dashed boxes.

Framing teaches Biomek 
Software the location of 
the devices positioned on 
the deck. Biomek 
Software uses this 
framing information to 
move the pod to the 
appropriate position 
when performing liquid-
handling operations and 
manipulating labware. 
A Beckman Coulter 
Service Engineer frames 
the Biomek 3000 
instrument during system 
installation. It may be 
necessary to repeat the 
framing if devices are 
added, moved, or 
removed from the deck. 
Refer to the Biomek® 
3000 Laboratory 
Automation Workstation 
User’s Manual, Chapter 
13, Framing the 

Framing 

Devices Types List

Biomek 3000 workstation 
deck positions

Side module deck positions
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5. Drag and drop ToolRack to any location capable of supporting it (Figure 3-17). 
A second ToolRack has been added to the deck. This deck is now the default 
deck and is available in the Instrument Setup step.

Figure 3-17.  TwoToolRacks deck with second tool rack added

6. Select Open Deck. Select a Deck appears (Figure 3-18).

Figure 3-18.  Select a Deck

7. Choose Deck1 to make it the default deck since it is the deck you used when you 
created the Quick Start Method and choose OK.

8. Choose Save to exit the Deck Editor.
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3.8 Manually Controlling the Pod
If you need to control the Biomek 3000 instrument outside of a method, including 
moving the bridge and head assembly outside of a method, you will use Manual 
Control. Manual Control is also used to control the pod when framing the gripper 
tool and when recovering from errors. Some devices can also be controlled outside a 
method using Manual Control. Refer to the Biomek® 3000 Laboratory Automation 
Workstation User’s Manual, Chapter 14, Manually Controlling the Biomek® 3000 in 
Biomek Software, for additional information.

Using the following instructions, you will use Manual Control to move the pod to a 
different position on the deck. You’ll move the pod to the Z-max height first to make 
sure you don’t hit anything on the deck and then you’ll move the pod to a selected 
position.

Note:  If you launch the simulator, you can watch the pod move as you complete the 
following steps.

To move the pod using Manual Control:

To home all axes and move the head assembly using Manual Control:

1. Choose Instrument>Manual Control. Manual Control appears (Figure 3-
19). Here is where you can choose to which position you want to move a pod.

Figure 3-19.  Manual Control
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2. Select Advanced Controls and highlight Pod1. Advanced Manual Control: 
Pod1 appears (Figure 3-20). 

Figure 3-20.  Advanced Manual Control for the Biomek 3000 head assembly

3. Select Move Z-Max. The head assembly moves to the highest configured height.

4. Select Close. Advanced Manual Control: Pod1 closes.

5. From Manual Control, click on P5. The head assembly moves to position P5 on 
the deck.

6. You can click on additional positions to move the pod to that position. When you 
are finished moving the pod with Manual Control, choose Exit to close Manual 
Control.

7. From the toolbar, choose Close to close the quick-start method.

OR

From the File menu, choose Close. The method closes and you are now ready to 
create a method of your own. 
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3.9 Quick-Start Guide Summary
Congratulations! You’ve just completed this quick-start guide. 

You’ve completed:

• a small method.

• steps using the editors.

• steps creating some new project items.

• steps to manually control the Biomek 3000.

If you’ve used the links to other manuals, you’ve also learned where to find hardware 
information on the Biomek 3000 and more information on Biomek Software.

Enjoy your new Biomek 3000 Laboratory Automation Workstation.




	Biomek® 3000 Laboratory Automation Workstation
	Warranty and Returned Goods Requirements
	Table of Contents
	Warranty and Returned Goods Requirements iii
	Table of Contents v
	1 Introducing the Biomek®�3000 Laboratory Automation Workstation
	1.1 Introduction 1�1
	1.1.1 How to Use This Quick-Start Guide 1�2

	1.2 Biomek® 3000 Laboratory Automation Workstation 1�3
	1.2.1 Bridge 1�3
	1.2.2 Head Assembly 1�4
	1.2.3 Tools 1�4
	1.2.4 Labware Positioners 1�4
	1.2.5 Tool Racks 1�4
	1.2.6 Optional Devices 1�5

	1.3 Biomek Software 1�6
	1.4 Starting the Biomek® 3000 1�7
	1.4.1 Turning On the Biomek 3000 1�7
	1.4.2 Launching the Software 1�7
	1.4.3 Homing All Axes of the Biomek® 3000 Pod 1�8


	2 Learning to Create Methods for the Biomek® 3000
	2.1 Overview 2�1
	2.2 Creating a New Method 2�2
	2.3 Configuring the Instrument Setup Step 2�4
	2.4 Configuring a Transfer Step 2�9
	2.4.1 Inserting a Transfer Step 2�9
	2.4.2 Configuring Tip Handling 2�10
	2.4.3 Configuring Source Labware 2�11
	2.4.4 Configuring Destination Labware 2�12

	2.5 Configuring a Move Labware Step 2�14
	2.6 Using the Finish Step 2�15
	2.6.1 Handling Configuration Errors 2�15

	2.7 Saving a Method 2�16
	2.8 Running a Method 2�17

	3 Using the Editors While Creating Methods
	3.1 Overview 3�1
	3.2 General Description of Editors 3�2
	3.2.1 Project Menu 3�3
	3.2.2 Instrument Menu 3�3

	3.3 Creating New Labware in the Labware Type Editor 3�5
	3.4 Creating a New Pattern 3�8
	3.5 Checking In a Method and Project File 3�12
	3.6 Using Hardware Setup 3�13
	3.7 Creating a New Deck 3�15
	3.8 Manually Controlling the Pod 3�17
	3.9 Quick-Start Guide Summary 3�19


	Introducing the Biomek®�3000 Laboratory Automation Workstation
	1.1 Introduction
	1.1.1 How to Use This Quick-Start Guide

	1.2 Biomek® 3000 Laboratory Automation Workstation
	1.2.1 Bridge
	1.2.2 Head Assembly
	1.2.3 Tools
	1.2.4 Labware Positioners
	1.2.5 Tool Racks
	1.2.6 Optional Devices

	1.3 Biomek Software
	1.4 Starting the Biomek® 3000
	1.4.1 Turning On the Biomek 3000
	1.4.2 Launching the Software
	1.4.3 Homing All Axes of the Biomek® 3000 Pod


	Learning to Create Methods for the Biomek® 3000
	2.1 Overview
	2.2 Creating a New Method
	2.3 Configuring the Instrument Setup Step
	2.4 Configuring a Transfer Step
	2.4.1 Inserting a Transfer Step
	2.4.2 Configuring Tip Handling
	2.4.3 Configuring Source Labware
	2.4.4 Configuring Destination Labware

	2.5 Configuring a Move Labware Step
	2.6 Using the Finish Step
	2.6.1 Handling Configuration Errors

	2.7 Saving a Method
	2.8 Running a Method

	Using the Editors While Creating Methods
	3.1 Overview
	3.2 General Description of Editors
	3.2.1 Project Menu
	3.2.2 Instrument Menu

	3.3 Creating New Labware in the Labware Type Editor
	3.4 Creating a New Pattern
	3.5 Checking In a Method and Project File
	3.6 Using Hardware Setup
	3.7 Creating a New Deck
	3.8 Manually Controlling the Pod
	3.9 Quick-Start Guide Summary


	Glossary

